Linear Modeling-Trendlines

The Problem -  To date, we have studied linear equations (models) where the data is perfectly linear.  By using the slope-intercept formula, we derived linear equation/models.  In the “real world” most data is not perfectly linear.  How do we handle this type of data?  

The Solution - We use trendlines (also known as line of best fit and least squares line). 

Why - If we find a trendline that is a good fit, we can use the equation to make predictions.  Generally we predict into the future (and occasionally into the past) which is called extrapolation.  Constructing points between existing points is referred to as interpolation.

Is the trendline a good fit for the data?

To answer this question, you need to address the following five guidelines:

Guideline 1:  Do you have at least 7 data points?  For the datasets that we use in this class, you should use at least 7 of the most recent data points available.  If there are more data points, you will also want to include them (unless your data fails one of the guidelines below).  What if you have 5 or 6 data points?  It is a judgment call… we will discuss this in class.

Guideline 2:  Does the R-squared value indicate a relationship?  R2 is a standard measure of how well the line fits the data. It is more useful in the negative sense: if R2 is very low, it tells us the model is not very good and probably shouldn't be used. The R-squared value is also called the Coefficient of Determination and can be written as r 2 or R2.

If the R2 = 1, then there is a perfect match between the line and the data points.  If the R2 = 0, then there is no relationship between n the x and y values.  If the R2 value is between .7 and 1.0, there is a strong linear relationship and if the data meets all the other guidelines, you can use it to make predictions.  If the R2 value is between .4 and .7, there is a moderate linear relationship and the data can most likely be used to make predictions.  If the R2 value is below .4, the relationship is weak and you should not use this data to make predictions.

More facts…..
· The coefficient of determination, r 2, is useful because it gives the proportion of the variance (fluctuation) of one variable that is predictable from the other variable.
· It is a measure that allows us to determine how certain one can be in making
predictions from a certain model/graph.
· The coefficient of determination is the ratio of the explained variation to the total
variation.
· The coefficient of determination is such that 0 <  r 2 < 1,  and denotes the strength of the linear association between x and y. 
· The coefficient of determination represents the percent of the data that is the closest to the line of best fit.  For example, if r = 0.922, then r 2 = 0.850, which means that 85% of the total variation in y can be explained by the linear relationship between x and y (as described by the regression equation).  The other 15% of the total variation in y remains unexplained.
· The coefficient of determination is a measure of how well the regression line
represents the data.  If the regression line passes exactly through every point on the scatter plot, it would be able to explain all of the variation. The further the line is away from the points, the less it is able to explain. 
http://mathbits.com/MathBits/TISection/Statistics2/correlation.htm

Calculating the coefficient of determination

The mathematical formula for computing r is:
                            
                                   where n is the number of pairs of data.

To compute r2, just square the result from the above formula.

Guideline 3:  Verify that your trendline fits the shape of your graph.  For example, if your trendline continues upward, but the data makes a downward turn during the last few years, verify that the “higher” prediction makes sense (see practical knowledge).

In some cases it is obvious that you have a localized trend.  Localized trends will be discussed at a later date.

Guideline 4:  Look for outliers:

Outliers should be investigated carefully. Often they contain valuable information about the process under investigation or the data gathering and recording process. Before considering the possible elimination of these points from the data, try to understand why they appeared and whether it is likely similar values will continue to appear. Of course, outliers are often bad data points.  If the data was entered incorrectly, it is important to find the right information and update it.  

In some cases, the data is correct and an anomaly occurred that partial year.  The outlier can be removed if it is justified.  It must also be documented.

Guideline 5:  Practical Knowledge:  How many years out can we predict?  Based on what you know about the topic, does it make sense to go ahead with the prediction?  Use your subject knowledge, not your mathematical knowledge to address this guideline.


Adding a Trendline (in both Excel 2007 and Excel 2003)

Using Excel 2007

Open the file:  MileRecordsUpdate.xls and calculate the slope (average rate of change) in column C.  
Is this women’s data perfectly linear?  No, there is not a constant rate of change.  (See table below.)


	Date
	Women's Record
	 

	 
	seconds
	Change

	1967
	277
	 

	1969
	276
	-0.50

	1971
	275
	-0.50

	1973
	269
	-3.00

	1979
	262
	-1.17

	1981
	261
	-0.50

	1985
	257
	-1.00

	1989
	255
	-0.50

	1996
	253
	-0.29



Graphing the data produces the following graph which confirms that the data is not perfectly linear. To graph data, highlight the data you want to graph (not headers or empty cells).  Choose a chart type:  Under the Insert tab click on Scatter located under the Charts group. Under Scatter, choose Scatter with only Markers (the first option). A simple graph is created.

We can clearly see that the data is not linear but we can use a linear model to approximate the data.  You will need to add a title, axis labels and trendline (including the equation and r-squared value). First click on the graph to activate the Chart Tools menu and then choose the Design tab.  Under the Charts Layout group, select #9. (Click on the "more" arrow to display all eleven layouts. Slide over each layout until you locate #9.)  Your graph should look like this:



Click on the Chart Title and add a descriptive title (consider who, what, where and when).  Click on each Axis Title and label both your x-axis (horizontal axis) and your y-axis (vertical axis).  If you are graphing only one series of data, always be certain to remove the legend (just click on the legend and use either the delete or backspace button).  To move the equation/r-squared value slide on the text box containing both the equation/r-squared value.  Once your cursor changes to "cross-hairs" press on the left mouse button and slide the text box to a location on the graph where it is easier to read. 

It is suggested that you remove the minor axis gridline by changing them to the same color as your background.   Right-click on the y-axis (vertical axis), choose Format Minor Gridlines then Solid Line.  Change the color of the line to match your background (currently your background is white).

It is important to add a text box stating the data source used to create the graph.  Under the Insert tab choose text box under the Text group.  Draw a text box on your chart and then type in "Source:" followed by the data source.  If no data source is listed, type "Unknown".



The black trendline is the line that “best fits” the data.  It is a line that comes as close the all the data points as possible.  

The R2 value indicates how linear the data actually is.  The R2 value will be a decimal  between 0 and 1.  The closer it is to one, the closer the data is to linear.  The smaller the R2 value, the less linear the data.  We can see here that the R2 value for the women’s mile record is .9342 which is very close to one, so the data is very close to linear.  

The equation is the equation of the trendline in y = mx + b form.  We can see that the slope or the rate of change of the trendline is -.929 which means that according to the trendline, the mile record is decreasing by just under 1 second every year.  

Why do we add a trendline and how do we use it?  Since the trendline is an approximation what is happening with data, we can use it to make predictions about the data.  

For example, to predict what the mile record was in 1999, use the equation of the trendline.  First identify the variables.  X is year and Y is record in seconds.  Then plug 1995 in for X in the equation and solve for Y.  y = -.929*1999 + 2103.4; y=246.  So according to the trendline, the women’s mile record in 1999 was 246 seconds.  

You may have learned in class to use the =slope() and +intercept() functions.  We recommend using the slope and intercept functions when you are modeling because the equation that Excel puts on the graph is often rounded to only a few decimal places. Using the equation that Excel puts on the graph can lead to aberrant results because of this rounding.
To calculate your prediction, type "slope" in cell B16 and "intercept" in cell B17.  (You can actually choose any empty cell that is convenient.) Next, in the neighboring cell, type "=slope(".  At this point, Excel will prompt you to select the y-values and the x-values with your mouse.  After selecting the appropriate y-values and x-values, your screen will look like:

Finally, type a closing parenthesis and press enter.

Repeat the process with the "intercept" function:

When are done, you will have the slope and intercept of the least squares best fit line in cells C16 and C17 respectively: 

To make your prediction, type "=C16*1999+C17" in a cell somewhere.  Type your prediction (expressed in the appropriate units) into your Word document.


So according to the trendline, the women’s mile record in 1999 was 246 seconds.  



Another example: In what year will the women’s mile record be 3 minutes?  Here you are asked to find a year given a record, so plug 180 (3 minutes=180 seconds) in for Y and solve for X. 180 = -.929X + 2103.4.  First subtract 2103.4 from both sides, then divide by -.929.  X = 2070.  Remember to round years to the nearest whole number.  So according to the trendline, the women’s mile record will by 180 seconds in the year 2070.

However, do we have confidence in that prediction?  Do they make sense?  Do they seem realistic?  To answer these questions, address the five guidelines listed above.  


Using Excel 2003

Open the file:  MileRecords.xls and calculate the slope (average rate of change) in column C.  
Is this women’s data perfectly linear?  No, there is not a constant rate of change.  (See table below.)

	Date
	Women's Record
	 Rate of Change

	 
	seconds
	 

	1967
	277
	 

	1969
	276
	-0.5

	1971
	275
	-0.5

	1973
	269
	-3

	1979
	262
	-1.16667

	1981
	261
	-0.5

	1985
	257
	-1

	1989
	255
	-0.5




Graphing the data produces the following graph which confirms that the data is not perfectly linear. To graph data, highlight the data you want to graph (not headers or empty cells) Highlight the data you want to graph. Click on the "Chart Wizard" button at the top of the screen: .  You will get a menu that looks like:

Choose the sub-type with data points and straight lines connecting (if there is a lot of data close together, the straight lines without data points is a good choice).  Click next then next again.  Give the graph an appropriate title and axes labels.  Click Finish. 



We can clearly see that the data is not linear but we can use a linear model to approximate the data.  To add a linear trendline to the graph, first complete the graph, then place the cursor on one of the data points and right click.  Choose “add trendline”.  The default type is linear which is what we want.  Click on the options tab and check “display equation on chart” and “display R2 on chart”.  
The graph should look like this:


The black trendline is the line that “best fits” the data.  It is a line that comes as close the all the data points as possible.  

The R2 value indicates how linear the data actually is.  The R2 value will be a decimal  between 0 and 1.  The closer it is to one, the closer the data is to linear.  The smaller the R2 value, the less linear the data.  We can see here that the R2 value for the women’s mile record is .9688 which is very close to one, so the data is very close to linear.  

The equation is the equation of the trendline in y = mx + b form.  We can see that the slope or the rate of change of the trendline is -1.0981 which means that according to the trendline, the mile record is decreasing by just over 1 second every year.  

Why do we add a trendline and how do we use it?  Since the trendline is an approximation what is happening with data, we can use it to make predictions about the data.  

For example, to predict what the mile record was in 1995, use the equation of the trendline.  First identify the variables.  X is year and Y is record in seconds.  Then plug 1995 in for X in the equation and solve for Y.  y = -1.0981*1995 + 2437.1; y=246.  So according to the trendline, the women’s mile record in 1995 was 246 seconds.  

Another example: In what year will the women’s mile record be 3 minutes?  Here you are asked to find a year given a record, so plug 180 (3 minutes=180 seconds) in for Y and solve for X. 180 = -1.0981X + 2437.1.  First subtract 2437.1 from both sides, then divide by -1.0981.  X = 2055.  Remember to round years to the nearest whole number.  So according to the trendline, the women’s mile record will by 180 seconds in the year 2055.

However, do we have confidence in that prediction?  Do they make sense?  Do they seem realistic?  To answer these questions, address the five guidelines listed above.  
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